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RocketDriver Pro is a game framework for Unity engine

Getting Start

Overview

This User Manaul was designed to provide GaemDriver Pro users with a basic
overview of the features and functionality of the tool.

Install

1. After downloading RocketDriver Pro from Unity’s Asset Store, go to: “Assets-
>Import Package->Custom Package...”.
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2.In the Import Assets window, find and select the RocketDriver Pro
UnityPackage file.

3. Once Unity appears in the Import Packages window, verify that Import is
selected for all projects, then click the Import button at the bottom right of
the window.

4. All RocketDriver Pro files will be added to Assets/JLGames/RocketDriver.

You can also select the desired section to import.
support

If you want to quickly understand the important features in RocketDriver Pro, you
can directly refer to the examples in JLGames/RocketDriver/Samples.

If you want to learn more about the design ideas and details of each functional
module in RocketDriver Pro, you can find more information and FAQs in Online
Help .

If you can’t find the information you're looking for, please file an issue (or submit a
pull request) to describe your experience.

Or contact the author: xuzhuoxi@gmail.com or mailxuzhuoxi@163.com

Features

Source code storage locations in RocketDriver Pro are regular.

e The source code in JLGames/RocketDriver/Runtime/CSharp only depends
on the C# standard library, ** does not depend on the Unity standard library.
It is an extension to C#.

e The source code in JLGames/RocketDriver/Runtime/Actions depends on
CSharp and the Unity standard library. It is a functional extension to the Unity
engine.

e The source code in JLGames/RocketDriver/Runtime/Games depends on
CSharp and Actions. It is a general implementation of system functions
commonly used in the game development process.

Functional Overview
JLGames/RocketDriver/Runtime/CSharp

The namespace is JLGames.RocketDriver.CSharp
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Algs
Transparent algorithm related functions
o AStar
A* general algorithm

Archive
File archiving related functions, now including zip decompression function
Buffer
The byte data cache function supports reading and writing of big and small
endian settings and basic data types.
DateTimex
Time related functions. Contains calculation conversions between time units,
string formatting of times, timers that support pause and resume, and more.
Event
Event related functions. Contains event monitoring, removal and scheduling
functions. For details, see 1.Event System(Event)
Extensions
Extensions for basic data types in CSharp.
Imagex
Image related functions. Now includes RGBA data objects, filter processing
functions, and more.
Languages
Other programming language related

o Lua: Lua interpreter

Mathx
Mathematical calculation related functions.
Net
Socket API definition, message encapsulation and unpacking functions, etc.
Pool
Object pool related functions. Contains Key-Value object pool, metadata
object pool, reuse object pool, etc.
Service
Service framework basic support. For details, see 7. Service
Framework(Service)
TinyJson
Simple Json reading and writing library. Open source from Github:
https://github.com/zanders3/json .
Utils
Common tool functions based on CSharp
o Encrypt
Encryption and decryption related functions, now including Des,
Rijandel, RSA
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o ArrayUtil
Array related functions, such as array cloning, merging, type
conversion, array matrix rotation and other functions

o BitUtil
The bit operation function of numeric values.

o ConfusedUtil
Data Obfuscation related functions.
+DirectionUtil
Directory related functions in the file system.

o FileUtil
File related functions in the file system.
o PathUtil
Path related functions in the file system.
+PrintUtil
Print support for object information.
o ReflexUtil
Reflection value-related functions.
o TextUtil
Character file read and write functions.
o Xml
XML related function support: serialization and deserialization
e Callback

Generic Callback Context
e ICloneable
Generic clone interface

JLGames/RocketDriver/Runtime/Actions
The namespace is JLGames.RocketDriver.Actions

e Animatorx
Feature support for Unity’s animation system. Contains animation search,
animation playback, event management and other functions.

e AssetIndex
The Editor function provides the ability to generate a “name -> path” index
for assets in the project.

e Audio
Audio Manager, which provides the function of unified management of audio
in the project. For details, please see 5. Audio Manager (AudioManager).

e Component
Some useful components.

e Component2D
Some useful 2D components.
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DateTimex
Time-related functions, including timers that rely on the Unity engine, cycle
time slice functions, etc.
ExcelExporter
Function support for exporting data from the third-party table export tool
ExcelExporter.
Extensions
Extensions to commonly used data structures in Unity.
Graphicsx
Image related functions. Contains color conversion functions, image pixel
data structures, texture functions, etc.
i18n
Internationalization function. For details, see 3. Internationalization
System(i18n).
Jsonx
Related functions for Json processing.
Languages
o Lua: Lua extension support on Unity engine

Layer

Unity displays the structural layered design capabilities.

Loaderx

Resource loading management module. For details, see 2. Loader System
(Loader)).

Localx

Depends on the local storage capabilities of PlayerPrefs.

Pool

The object pool function extends the object pool function in

JLGames/RocketDriver/Runtime/CSharp/Pool, and adds parts related to Unity.

Service
Service framework Unity support. For details, see 7. Service
Framework(Service)
TheadEvent
Event related functions. Added Unity multithreading support to
JLGames/RocketDriver/Runtime/CSharp/Event.
UIElements
Editor function. It is an extension to the UIElements functionality in Unity.
Utils
Rely on common functions of Unity.
o CameraUtil
Camera related functions.
o CaptureUtil
Screenshot related functions.
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o ComponentUtil

Component related functions.

+DebugUtil

Debug printing related functions.
o GeometryUtil

Geometric calculation related functions.
o IdentifyUtil

Machine Id related functions.
o ImageUtil

Image related functions.
o MathfUtil

Mathematical calculation related functions
o PositionUtil

Unity object position calculation related functions.
o TilemapUtil

Common public behavior under the UnityEngine.Tilemaps component.

o TransformUtil
UnityEngine.Transform component related extension functions.
o UnityPathUtil
Untiy-related path handling functions.
Wait
Unity coroutine related functions.

JLGames/RocketDriver/Runtime/Games

The namespace is JLGames.RocketDriver.Games

LocalAccount

Local account storage function.

NetManager

Network connection management, virtual servers. For details, see 4. Network
Manager (NetManager).

PanelManager

Panel management module. For details, see 6. Panel Manager
(PanelManager) +RpgMaterial

Game data management system. Please see 8.RPG Material Data
System(RpgMaterial) for details.

Service

Common service instances under the service framework. For details, see 7.
Service Framework(Service).

Tiledx

Data interpretation capabilities for third-party software Tiled.

Common function modules
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1. Event - Efficient event module, supports Unity
multithreading

The event adopts the “monitoring-capture” mechanism, which supports the
settings of the number of captures and capture priority during monitoring.

e JLGames.RocketDriver.CSharp.Event is responsible for the core logic
implementation of the event system.

¢ JLGames.RocketDriver.Actions.ThreadEvent provides support for
multithreading.

1.1 Core functions - add listeners, remove listeners, dispatch
events

1.1.1 Monitoring

The AddEventListener series of functions in the interface IEventListener are

used to add event listeners.
The logic implementation has been completed in the implementation class
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EventDispathver.

/// <summary>
/// Addsingle event listener
/1] ERMBIREEE T
///  </summary>
/// <paramnane="type" >Event Type<br/>ZE {428 </ param»
/// <paramnane="handl er " >Li stener Functi on<br /> 0frERZY </ par ame
/// <paramnane="wei ght " >Response Wi ght <br/ >l[g i/ 1% & </ par am»
/// <paramnane="tag" >Function Tag<br/>REHIMHE—FREE </ paramy
(string 3
, string

<summary>

Add event listener

AR INEE S O

</summary>

<par am nane="type" >Event Type<br/>E{F3EH) </ parany

<par am nane="handl er " >Li stener Functi on<br/ >l 0frERZEY </ par any

<par am nane="tag" >Functi on Tag<br/>FEHIHE—IRE </ parame
(string :

<summary>

Add event listener

NS R O

</summary>

<param nane="type" >Event Type<br/>ZS{4-358 </ param»

<param nane="handl er " >Li stener Functi on<br/ >0 ER% </ parame

<par am nane="wei ght " >Response Wéi ght <br / >l f7#X & </ par am»

<par am nane="tag" >Functi on Tag<br/ > EAME—FREE </ parame
(string -

<summary>
/// Addevent listener
/1] ARINEET
///  </summary>
/// <param nane="type" >Event Type<br/>Z{43EE! </ param>
/// <paramnane="handl er" >Li stener Functi on<br/ > % </ param
/// <paramnane="listeni ngTi nes" >Ti n@s of responses <br/ >l[i ;X EY] </ par am>
/// <paramnane="tag" >Functi on Tag<br/ >R EHIME—HREE </ paramr
(string ; ) . uint

string

/// <summary>
/// Addevent listener
/1] RINE ST
///  </summary>
/// <paramnane="type" >Event Type<br/>ZF {4281 </ param>
/// <paramnane="handl er " >Li stener Functi on<br /> IfreR%Y </ parame
/// <param nane="wei ght " >Response Wi ght <br / >[J i/ 1Y & </ par am»
/// <paramnane="l1i steni ngTi nes" >Ti nes of responses <br/ > [REL </ par amy
/// <paramnane="tag" >Functi on Tag<br/>REHIHE—FIRE </ parame
(string ; 1 , int
, string = null );
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1.1.2 remove monitor

The RemoveEventListener series of functions in the interface IEventListener are
used to remove event listeners.

The logic implementation has been completed in the implementation class
EventDispathver.

Summary

imma
paran
param:

EventDelegates.EventHandler handler,

param A< /param:

g type,

paran:
g type);

1.1.3 Distributing events

The DispatchEvent series of functions in the interface IEventDispatcher are used

to distribute events.
The logic implementation has been completed in the implementation class

EventDispathver.

summanry

[ SUmmary
param

param

param
data);

1.1.4 Multithreading support
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The functions declared in the interface IThreadEventProxy define the
multithreading support specification.

The logic implementation has been completed in the implementation class
ThreadEventDispatcher.

SLUmma iy

summa iy
param name

1 OpenMainThre

Summairy

Sumimary

Clo

1.1.5 Extensions

Extends EventDispathver or ThreadEventDispatcher and implements a custom
interface that can be used to extend event behavior.

1.2 Example

JLGames/RocketDriver/Samples/Event

Prowy SEta Nama

AddEwvemn

RermoveEvant

OncaEvant

HallaWWorkd! DispaichEvant

re sults!

Please go to Console to se
H Bl ConsoleE &4

2. Loading management module (Loader) - supports
free switching of three modes: Resources, Editor,
Assetbundie

e JLGames.RocketDriver.Actions.Loader provides full support for the loader.
e “Tools -> RocketDriver -> Project -> Gen LoaderSettings” provides the
generation entry for the loader configuration file.
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2.1 Initialization

2.1.1 Generate configuration assets

Execute menu “Tools -> RocketDriver -> Project -> Gen LoaderSettings”.
The LoaderSettings.asset (renameable) file will be generated under the project

Assets/Resources.
£ LoaderSettings

by Bundle ings

EFALRN:
Run Mode Debug
TRALLN.

{ Editor

2.1.2 Set configuration according to project requirements

There are 5 available configurations in LoaderSettings, one Editor mode, two
Resource modes, and two AssetBundle modes.

e Editor configuration ProjectBasePath can set the base path part of the
project’s resource search, which can be spliced before the resource path
when loading resources.

e Resource configuration ProjectBasePath can set the base path part of the
project’s resource search, which can be spliced before the resource path
when loading resources.
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e AssetBundle configuration

o BundleSource You can choose three modes: Web, Streaming Assets, and
File Debug.
m Web Used to load AssetBundle assets stored directly on the site.
Fill in the site Url in Web Site Url.
Fill in the Parttern path in the Web Site Pattern.

Properties

armple.com

= Streaming Assets Used to load AssetBundle resources stored in the
project StreamingAssets.
Fill in the relative path relative to StreamingAssets in Streaming

https://www.xuzhuoxi.com/RocketDriver-Docs/pages/Manual_Full_en.html 12/88



2023/11/11 16:09 User Manual | RocketDriver Pro

Parttern.

» File Debug Used to load AssetBundle resources in the local file
system, mostly used for debugging.
Fill in the local file path in File Url.
Fill in the relative path related to File Url in File Pattern.

None

o Base Settings It is mainly about the setting of the Bundle directory
information of the project and the setting of the cache information

when loading.
m Project Base Path Set the Bundle directory path of the project
m CacheName Set the name of the cache area, this can be

customized.
m Version Size Sets the number of versions of each Bundle asset to

keep in the cache.
m History size sets the number of cache areas, each CacheName will

generate a cache area.

o Resource Release Strategy There are three options: None, Time, and

Counter.
= None means that the release strategy is not selected. The invalid
memory occupation generated after releasing the Bundle and
assets needs to be released by calling gc. This strateqgy is suitable
for self-management of memory and gc timing.
» Time is a timing release strategy, which will call gc according to the
set time period.
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= Counter is a count release strategy. When the bundle loaded
resource reaches the set value and multiple value, gcis called.

Counter

16

2.1.3 Initializing Loaders with Configuration

Initialize the loader with the following API:

¢ Initialize with the configuration file name generated by first point.

summary

./ summ
“param

4 param>
"
param

param:

g loaderName = DefaultName, strin

g settingsName = DefaultName)

summary
param f param
param name t >< fparam>
returns 1
€S Iloader Initloader(string loaderMame, lLoaderSettings settings)
5. IsNullOrEmpty { loaderName) ||

ontain (loaderName)}) return m

setting

loaderMName];
== loader) 1 ;
s[ loaderName ] loader;

(DefaultName == loaderName)

m_Defaultleo » = loader;

loader;

summ

param ri param

: settingsName = LoaderManager.DefaultName)

(LoaderManager.DefaultName, settingsName);

2.1.4 Initialize Bundle version information
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Call the function in the loader instance:

summary

mmar
param
IEnumerator InitVersio Jelegate.OnfAss ded< st> onVersionAssetBundleloaded);

e The function callback is executed after the initialization version ends, and the
initialization result can be judged internally: success or failure.

e The function requires to open the coroutine call, you can use
LoaderManager.Mono to open the coroutine:

summary

summary
</param>
ssetBundleManifest> onVersionloaded)

er.InitVersion(onVersionloaded));

2.2 Use

2.2.1 Load Bundle assets

Bundle assets can be loaded only after the Bundle version information is initialized.
The loader implements the IBundleLoader interface and contains functions related
to loading Bundle assets.

Loading Bundle assets requires the use of coroutines, which can be enabled using
a LoaderManager.Mono instance to load Bundles by coroutines.

summary

imary

param

param

param

para a i< /param

0 = bundleName, Lo te.0D eloaded onBundleloaded,
ol auto unloadAllloadedObjects

LoaderManag .Startl ef V ultloader.Lo nc(bundleName, onBundleloaded,

autoRel

e bundleName: bundle asset name.

e onBundleLoaded: Execute the result callback, which can be used to determine
whether it is successful or not.

e autoRelease: Indicates whether to release the bundle instance after
onBundleLoaded execution ends

e unloadAllLoadedObjects: Indicates whether to release the resource assets
instantiated from the bundle instance after onBundleLoaded execution ends
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e If autoRelease is true, all assets to be used should be instantiated in
onoBundlelLoaded.

2.2.2 Loading resource assets

In the case of obtaining the bundle instance, the instance of the resource asset can
be instantiated from the bundle instance, and then cloned and used.

It is recommended to use synchronous functions for loading resource assets, and
asynchronous functions are not recommended. The reason is that Unity does not
support opening coroutines within coroutines friendly, and if there are too many
layers (like 16 layers), unpredictable errors will appear.

The IAssetLoader interface functions are divided into four categories:

¢ Single resource asset loading (sync|async)

T LoadAssetSync<T>(string assetPath, AssetBundle bundle) where T : Object;

T LoadAssetSyncFull<T>(string fullPath, AssetBundle bundle) where T : Object;

IEnumerator LoadAssetAsync<T>(string assetPath, AssetBundle bundle,
LoaderDelegate.OnAssetLoaded<T> onAssetLoaded) where T : Object;

https://www.xuzhuoxi.com/RocketDriver-Docs/pages/Manual_Full_en.html

16/88



2023/11/11 16:09 User Manual | RocketDriver Pro

e Batch resource asset loading (sync|async)

T[] LoadAssetsSync<T>(string[] assetPaths, AssetBundle bundle) where T : Object;

T[] LoadAssetsSyncFull<T>(string[] fullPaths, AssetBundle bundle) where T : Object;

IEnumerator LoadMulitAssetAsync<T>(string[] assetPaths, AssetBundle bundle,
LoaderDelegate.OnMultiAssetLoaded<T> onMultiAssetLoaded)
where T : Object;
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e Single sub-resource asset loading (sync|async)

Object LoadSubAssetSync(string path, string subName, AssetBundle ab);

Object LoadSubAssetSync(string path, string subName, Type type, AssetBundle ab);

T LoadSubAssetSync<T>(string path, string subName, AssetBundle ab) where T : Object;

IEnumerator LoadSubAssetAsync<T>(string assetPath, string subName, AssetBundle bundle,
LoaderDelegate.OnAssetLoaded<T> onAssetLoaded)
where T : Object;
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e Batch sub-resource asset loading (sync|async)
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Object[] LoadSubAssetsSync(string path, Type type, AssetBundle bundle);

T[] LoadSubAssetsSync<T>(string path, AssetBundle bundle) where T : Object;

Object[] LoadSubAssetsSync(string path, string[] subNames, AssetBundle bundle);

Object[] LoadSubAssetsSync(string path, string[] subNames, Type type, AssetBundle

T[] LoadSubAssetsSync<T>(string path, string[] subNames, AssetBundle bundle) where T : Object;
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IEnumerator LoadSubAssetsAsync<T>(string assetPath, AssetBundle buundle,

LoaderDelegate.OnMultiAssetLoaded<T> onAssetsLoaded)

where T : Object;

e For more usage, please refer to the example, API or source code.
2.3 Example

JLGames/RocketDriver/Samples/Loader

Icons/RocketDriverlcon.png

3. Internationalization (i18n) - Lightweight
Internationalization Solution

e JLGames.RocketDriver.Actions.i18n provides full functional support for the
internationalization module.
e BabelEdit is recommended for authoring management datasets.
e Use internationalization (i18n) in three steps:
1. Prepare the data.
2. Initialize (Initialize by registering information or Initialize by
configuring assets).
3. Use.

3.1 Preparation

Understand the internationalization requirements of the project and prepare data
files.

3.1.1 Clarify the types of international languages that the project needs to
support
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Here are English[English], Chinese[Simplified], Chinese[Traditional] as
examples.

3.1.2 Prepare internationalization data files

Multiple file sets are supported, here are two file sets unity, rider for example.

i 'Compatient”,
Er.MmentL.
er.ment.Fll
rider.menu.Ga "“GameDblect”,
ider.menu.He
gr.menu.To !
"Man.der.menu. Window": "Window"

The current test dataset is authored using Jetbrains’ [BabelEdit]
(https://www.codeandweb.com/babeledit), which is a nice tool.

3.2 Initialize by registering internationalization informations
3.2.1 Register languages with the registry.

Call the RegisterLang function in the I18NRegister instance:

summary

summary
param n ] 1 > B =5 70< [ param N
param n 3 CUaE 2 ¢ 1o 5 XAt a%sR< /param

param : &= t TEssriantne = ) e param
' 3 ngName, string igSuffix, bool @default = f
2id langhame, : langSuffix, @default

langSuffix;
ng = langName;

¢ langName as langSuffix suggests.
e default=true sets the current language as the default language.
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3.2.1 Loading information to the registry registration file set

Call the RegisterFile function in the I18NRegister instance:

Lsummary

</ sum
param \
{param r undle of t F1le t i 1] | param:
{param r param
param r param
L ‘string fileKey, string fileBundle, string filePath, bool @default = false)

sterFileInfo(fileKey, fileBundle, filePath);
= fileKey;

o fileKey is used to identify the currently set fileset.
e default=truej Set the current fileset as the default fileset.

3.2.3 According to the registry, load data into the manager

Call the LoadData function in the II18NManager instance:
I18NManagerShared.Manager.LoadData();

Summary

Summary
i LoadData();

NOTE: If you have performed load data in the past, you should clear the old data
first:
I18NManagerShared.Manager.Clearbata();

summary

summary
id ClearData();

3.3 Initialize by configuring asset

3.3.1 Generate configuration assets and configure information

1. Select the generation directory of the configuration assets, click the menu
“Tools -> RocketDriver -> Project -> Gen I18NSettings”.

2. The generated asset file is named “I18NSettings.asset”.

3. Set the extension name of the fileset: Asset Extension. “json” is suggested
here.

4. Add the fileset to the Assets configuration list. Or set one of them as default
(only the last default takes effect).
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=
@ 3t

Open

B rider_en-Us
efaLll
Element 1

Brider_zh-CHT

Brider_zh-CH

Bunity_en-US

B unity_zh-CHT

B unity_zh-CHN

i

3.3.3 Initializing data by configuring assets

Call the LoadDataFromSettings function in the II18NManager instance:

I18NManagerShared.Manager.LoadDataFromSettings(settings);
Summary .

summanry

param
LoadDatal

3.4 Use

3.4.1 Use the I18NTMPText component to add internationalization support to
TMP_Text.
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Add [18NTMPText component to TMP_Text node
¢+ TextMeshPro - Text (Ul)
v NBNTMP Text (Script)

Mane (TMP_Text)
unity

{118n.unity menu.Build}}

Add Component

¢ File Key is the fileKey parameter when registering a file set.
e Auto Refresh When checked, the manager will refresh itself after reloading
the data.

3.4.2 Use the I18NText component to add internationalization support to Text.
Add [18NText component to Text node

« Texnt
B ~ 18N Text (Script)

= | 4 o Pl
7o {iBn.unity . me

0

Add Component

¢ File Key is the fileKey parameter when registering a file set.
e Auto Refresh When checked, the manager will refresh itself after reloading
the data.

3.4.3 Reading internationalized data in code.
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I18NManagerShared.Manager.Getvalue(id, filekey, lang);

SUummary

(/S summary
param name

param na
{param name="f x4/ param:
returns returns:

ng GetValue(string id, string fileKey);

summanry

summary
{param n =k {param
param na Key param
param name="13 e" param

‘returns returns:

fileKey, string langhName);

3.4.4 Internationalize the text content in the code.

Support script format in the file content: °
I18NManagerShared.Manager.GetContent(content, filekey, lang);
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Summary .-

summary
param

Summary .-

summary
param name="1¢ e param
param name="fi y "' ></ param’
return
4

g Get ent{strinz content

> fileKey);

summa iy

Summary
param =t "< /param:
param t param
param ns gt I param
retur

content langhame) ;

3

3.5 Example

JLGames/RocketDriver/Samples/i18n

e s = : = RN default{unity) « B
T
5
i

Jack: Hello, {({I1Bn.unity. menu, Bulld}}
Luey: Hi, {{i18n.unity manu.Fila))

Test Id | Test Context

Reload by Top Infos

Reload by ScoptableCbject[l1BMSeattings asset]
Jack: Hello, #33t

Lucy: Hi, 34

4. Network management extension module
(NetManager)

Easy-to-use network link management module

¢ JLGames.RocketDriver.CSharp.Net provides a C# package for Socket AP,
which enables developers to develop protocols such as TCP, UDP,
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HTTP(HTTPS), WebSocket(WebSockets) on the same set of APIs.

e JLGames.RocketDriver.CSharp.Net also provides support and extension for
data packing and unpacking.

e Management of link references is available in
JLGames.RocketDriver.Games.NetManager.

e Extended support for stand-alone servers in
JLGames.RocketDriver.Games.NetManager.Virtual, which can simulate the
behavior of server protocol capture and logic processing without an actual
network connection.

4.1 Use of VirtualServer

4.1.1 Instantiate and add to NetManager management

var server = new VirtualServer("server", '"none");
NetManager.Shared.Register(server, true);

summary

summar

‘param Exty” param
param r fault' param
MNetEntity entity, beool @default = fal
11 = entity) ret

, INetClient, @default);

INetServer, @default);
Objects added to NetManager can be obtained by name.

4.1.2 Registering extensions

server.RegisterExtension(virtualReqIds.IdO,
OonRequestHandler) ;

'>< /param:
VirtualServerDelegate.OnProtoRequestHandler onProtoRequestHandler);

e protold: Protocol ID, defined by the developer.
e onProtoRequestHandler: Response function, corresponding to the response
management logic of the protocol number.
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4.1.3 Protocol response

Response delegate declaration:
VirtualServerDelegate.OnProtoRequestHandler

summary

summanry
param d" param:

param

iestHandler(IVirtualServer server, string protold,

e server: IVirtualServer instance, which is mainly used in the function to send
broadcast notifications of protocol results and data.

e protold: protocol number

e data: the data sent when the protocol requests

4.1.4 Message Push

erface contains function declarations for message push.

e The INotifyServer int
T ' INotifyServer

summary

summanry

param name="protoId" param:
param name="d : param
NotifyToClient(string protold,

e The IMaterialNotifyServer interface contains function declarations for pushing
messages related to material data.
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: ' ~ace IMaterialMNotifyServer

summary

“~f SUmMMmMary -
param nam

n

num" fparam:

4

NotifyMaterialEntryUpdate(DataNum num);

Summa ry

summary
cparam name="n 3
NotifyMaterialEntryUpdate(UserNotifyData notify);
summary

summary
param name="offsetArr"></param
NotifyMateri late(DataOffset[] offsetArr);
summary

Summary
param name="numArr" param

NotifyMaterialEntryUpdate(DataNum|[] numArer);

LSuUmmary

I{yﬁPP” param
ntryUpdate(UserNotifyData[] notifyArr);

e The server instance in the response delegate
VirtualServerDelegate.OnProtoRequestHandler has implemented the
INotifyServer and IMaterialNotifyServer interfaces, and realizes the data
broadcasting function by calling the message push function.

4.2 Use of VirtualClient

4.2.1 Instantiate and add to NetManager management.
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var client = new VvirtualClient("client", "none");
NetManager.Shared.Register(client, true);

summary

param
de 1t param
ister(INetEntity entity, bool @default =

11 = entity) ret
35 INetClient, efault);

INetServer, @default);

Objects added to NetManager can be obtained by name.

4.2.2 Connecting to the server

var serverProxy = NetManager.Shared.

GetServer<IVirtualServer>("server") as IVirtualServerProxy;

client.Connect(serverProxy);
Summary

summairy

Summanry

summanry

nect(IVirtualServerProxy server);

e Get the server proxy (actually the VirtualServer object) from the manager.

e The connection proxy function is Connect.
e The function to cancel the proxy connection is Disconnect.

4.2.3 Monitor request response, monitor message push
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The monitoring function is built under the event mechanism:

client.AddEventListener(virtualClientEvents.EventResponse,
onClientResponse) ;

client.AddEventListener(VvirtualClientEvents.EventNotify,
onClientNotify);

summary

summary .-

c EventResponse

sSummary

summary >
onst r EventNotify

4.2.4 Send message request

Use the Request function under the interface IVirtualClient to send a message
request to the server.

NetManager.Shared.GetClient<IVirtualClient>("client")
.Request(protoIld, m_InputRequestData.text.Trim());

sSummary .

summanry .-

param name="p d"></param

param

param n )
= y pﬁﬂtﬂIdJ

4.3 Example
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JLGames/RocketDriver/Samples/NetManager

Responss - HalloWaorld!

Matify - HilloWorld

5. Audio Manager (AudioManager)

The perfect audio management module supports scene and UI music sound
effects, and removes the dependency of Assetbundle.

¢ JLGames.RocketDriver.Actions.Audio provides full functional support for
audio management.

e Audio loading uses the default loader (Loader), but also supports custom
loader.

e Use Ico method to inject audio resource information.

e There is no need to directly reference audio resources, which realizes the
separation of resource usage and resource packaging.

e Support cache settings to reduce loading consumption.

5.1 Initialization
5.1.1 Generate configuration assets

Execute menu “Tools -> RocketDriver -> Project -> Gen AudioSettings”.
The AudioSettings.asset (renameable) file will be generated under the project
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Assets/Resources.
O [nspector

E{) R S SErr,

attings

Music Settings FRiER

Music Fade Time

Cache settings HPRE
i c |_I 1 |:_.'._. .

Mone (ALc
User Settings
Music Settings WRER
hMusic Volume
Volume
MLted

Sound Settings FMRE

Sound Volume

e SysSettings are system-level settings and cannot be modified by users.
e UserSettings are user-level settings, open to AP modification. I

5.1.2 Setting up management objects

Copy JLGames/RocketDriver/Assets/AudioManager/Prefabs/AudioManager.prefab
to the project initialization scene, and re-associate AudioSettings.asset
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O [nspector

."-"‘ +  AudioManager
v

Layer Default

Prefab Open Select Chvearrides

Transform

Audio Music Handler (Script)

Audio Sound Handler (Script)

ﬂ + Audio Manager (Script)

Cont Destroy On Load
Music Register Infos
Size
Music_1
Audio Key Music_1
Audio Bundle audio
Audio Path Musics/Forest_Loop.wav
Sound Register Infos
Size
Sound_1
Audio Key Sound_1
Audio Bundle audio
Audio Path Sounds/Sheep 01.wav

Add Component

e Dont Destroy OnLoad whether to save the object when the scene is destroyed
e Music Register Infos Music information preprocessing registry
e Sound Register Infos Sound effect information preprocessing registry

5.1.3 Set the audio loader:

AudioManagerpPool .Shared.SetLoaderAdapter(new AudioLoader());

If you need to customize the loading, you can implement the IAudioLoader
interface.

5.2 Use

5.2.1 Register audio information (optional)
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Audio information can be registered in the script using the AudioManager function

Lsummary

summary
param name=" "' >< /param
param n | yme " param
param nam param
RegisterMusic(string key, string bundleName,

ma ry

L summary
param name="key’ param:
Lparam n lame" / param
param:
key, string bundleName,

5.2.2 Play music, play sound effects

e Functions starting with SwitchMusic in AudioManger provide support for
playing music.
e Functions starting with PlaySound in AudioManager provide support for

playing sound effects.
e The playback of music sound effects supports direct playback without

registration.

5.2.3 Audio Settings
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e AudioManager supports music mute and volume settings.

summary

Summary
summa ™y

S LML ™Yy

param n "volume" param
: param
volume,

Ssummary

‘summary

param
param
volume,

summary

summary
param
param
muted, bool refres

5.2.4 It is recommended to use packaged components, such as:
AudioDemoMusicNode and AudioDemoSoundNode components in the example.
5.3 Example

JLGames/RocketDriver/Samples/Audio

n'.

- - - r

-
music 2 Musies/Sawer Loop 1 wav Sound 2 Sounds/Dog Bark 01.wav
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6. Panel Manager (PanelManager)

¢ JLGames.RocketDriver.Actions.Layer provides container level management.

¢ JLGames.RocketDriver.Games.PanelManager provides panel management
functions.

e The usage process of the panel management module: registration -> display -
> close

e If the cached panel is not destroyed, it is recommended to move the panel off
the screen.

6.1 Registration Information

6.1.1 Registration layer container information

PanelManagerShared.Manager.Register.RegisterLayer(containerName
tranContainer, isDefault);

Lsummary

summanry

param name=' rerName” param
param 7 1 /param:

'>< /param:
g layerName, Transform layer, bool @default = f

e layerName: Specify a name for the registered layer information, regardless of
the layer’'s name attribute.

e layer: The Transform component reference of the layer.

e default: Whether to set to default, if true, when opening the panel without
specifying a layer name, the default layer is selected.

6.1.2 Registering background processing information

PanelManagerShared.Manager.Register.RegisterBackground(backgrou
backgroundorigin, backgroundScript);

summary

‘summar b

param n "key' param:
param n n =</param:
param n C : param

1id Registe d{string key, GameObject origin,
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e key: Specify a key for the registered background information to identify the
uniqueness of the information.
e origin: The prefab for the background, when the panel is shown, the cloned
prefab is added to the bottommost layer of the panel container.
e script: The class name (including namespace) of the script component that
handles the background logic.

6.1.3 Register animation information

PanelManagerShared.Manager.Register.RegisterAnimator(animkey, ai

>

Summary .

summary
<param nsz
<param e mator" param
id RegisterfAnimator(strinz key, RuntimeAnimatorController animator);

e key: Specify a Key for the registered animation information, which is used to
identify the uniqueness of the information.
e animator: Animate the RuntimeAnimatorController component.

6.1.4 Setting the base container for the panel

PanelManagerShared.Manager.Register.RegisterPanelContainer(cont:

»

summanry

/ SUmMmary :

param
er(GameObject container);

e container: The prefab of the panel container. When the panel is displayed, the
cloned prefab is added to the display layer as the panel root node, and the
actual content task child node of the panel is added to the panel container.

6.1.5 Registration panel information

PanelManagerShared.Manager.Register.RegisterPanelInfo(panelld,
settings, maxDisplayNum, extendType);
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summanry

summa
param = param
3(IPanelInfo info);

summary

summa
param param
param param
param

3 > bundleName, string assetPath);

summary

summa
param param
param Et param
param
p m "e 74 / param
ngs settings, int maxDisplayNum, int extendType);

e Panel information is finally saved as an instance of IPanellnfo for search and
display.

e When the project is used, the configuration information of the project panel
should be read and registered.

6.1.6 Using the PanelManagerRegister component, you can handle the
registration function of layer container, background, animation and panel
information at the same time

Panel Manager Register (Script)

Show After Frame

0
antaines Mone (Game Object)
Panel Inf

Size

Add Component

6.1.7 Note

Background registration and Animation registration optional, only register
when there are relevant requirements in the panel information.

6.2 Display Panel
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6.2.1 To pop up a panel by panel id, you can select the specified panel layer
container.

PanelManagerShared.Manager.ShowPanel (panelId);

summary

i<br/>HIREIELE Id</param
< /param

ng panelld, r > layerName =

6.2.2 Pop up the panel through the panel id, and pass in the parameter object,
you can choose to specify the panel layer container.

PanelManagerShared.Manager.ShowPanel (panelId, panelParams);

summary

mme

param elId">P 1 Id<br/>EIFHIELE Id</param
param amsF

br/>E<R a ne liE A B2 B < /param>
param 1

- 1 r C espondi to the ps br/ >Rl ER S5 AR< /param
IPanelInstance 2 object @params, string layerName =

6.3 Close Panel

6.3.1 Close the panel by the panel id.

You can choose to close the default, close the first display, and close the last
display through the panel id:

SUummanry

summary
param n ’ d" >[H7 S Id</param

Close
summary
summary
cparam name="pa Id" >R BBl 2 Id</param
CloseFirstPanel(string panelld);

~SUmmanry

L summary

param I ' el Td" > EFR = Id</param
Closel

6.3.2 Close the panel through instance information.
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Close the panel accurately by providing the panel instance Id (instanceld), display
view (view), and panel instance (IPanellnstance).

summary

summary

param d" > [H 7
CloseInstacnePanel(string instanceld);

param
summary

summary
/param
view);

</param
instance);

6.3.3 Close panels in batches.

You can choose to close all displayed panels, close all panels with a specified panel
id, or close panels that match the matching function.

Lsummary

summanry

SLUmma ry

summary
param name="panelId">H7} S Id</param

summary

summanry
param name

ClosePar

6.4 Advanced Applications
6.4.1 Custom Registrar

The registrar in IPanelManager can be customized, as long as the IPanelRegister
interface is implemented.
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summary

summary

6.4.2 Custom Loaders

The loader in IPanelManager can be customized, as long as the

[IPanelLoaderAdapter interface is implemented.
summanry

Summary
param n -"loader” param:
Setloader(IPanellLoaderAdapter loader);

6.4.3 Set panel display timing

SetShowMoment in IPanelManger can set the panel display timing (immediate
display | frame end display)

~ SUummary ..

summary
param "showhAfterFrame":></param

SetSh ent(bool showAfterFrame);

e show immediately When the code is executed, the loading process is
performed immediately. Add panels to the display node as soon as the asset
is ready.

e end of frame display When the code is executed, the loading process is
performed immediately. When the resource preparation is complete, start the
coroutine, wait for WaitForEndOfFrame, and add the panel to the display
node.

6.4.4 IPanelSettings Description

The IPanelSettings instance is the interface of the panel configuration information
saved when the panel is registered, including resource configuration, background
configuration and animation configuration.

6.4.4.1 Resource Configuration

IPanelAssetSettings instance
Main configuration properties: BundleName, AssetPath, MainScriptName,
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MainScriptParams

Summary

summanry

Summanry
Summairy
summary

summanry
r

r MainScriptiame { get;

Summaiy

Ssummary .

MainScriptParams {

e BundleName The name of the Assetbundle where the panel assets are
located

e AssetPath The path of the panel asset in the Assetbundle

e MainScriptName If the panel has a main script, the full class name (including
namespace) of the main script is returned. Returns null or an empty string
without a main script. +MainScriptParams It takes effect when
MainScriptName exists and implements the IParamsPanel interface, and is
the incoming parameter of the function SetPanelStringParams.

6.4.4.2 Background configuration
IPanelBackgroundSettings instance

e basic parameters
o OriginKey The key specified when the background information is
registered
o OriginInfo Find out the registration information through the key
specified during the registration of the background information, and
take the origin prefab.
o Mode Four background modes are supported: None, Color, Image,
Screenshot
= None Dependency coefficient: none
m Color Dependency coefficient: Color
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= Image Dependencies: ImageSprite, ImageBundle, ImagePath,
BlurFactor
= Screenshot Dependency factor: ScreenshotFactor
e Mode related parameters
o Color [Valid when Mode=Color] background color value, used to set the
background color value
o ImageSprite [Valid when Mode=Image] Two cases: ImageSprite is not
empty, ImageSprite is empty.
m ImageSprite is not empty Ignore ImageBundle and ImagePath
parameters, use ImageSprite to fill.
m ImageSprite is empty Through the loader in Register, use
ImageBundle and ImagePath to load Sprite fills.

o ImageBundle and ImagePath [effective when Mode=Image] Used when
the ImageSprite is empty, to load the Sprite resource.

o BlurFactor [Valid when Mode=Image] Blur factor: [0,1]

o ScreenshotFactor [Valid when Mode=Screenshot] Screenshot image blur
factor

6.4.4.3 Animation Configuration

IPanelAnimSettings instance

summairy
Ssummairy
SLIMmMa ry

summary
o OpenState {

summa ™y

summanry

1 Closekey {

- SUMmMa ry

summairy

1z CloseState {

e OpenKey The key used when animation information is registered, used to find
animations
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e OpenState The state name in the animation Animator, used to play the

specified animation
e CloseKey The key used when animation information is registered, used to find

animations
e CloseState The state name in the animation Animator, used to play the
specified animation

6.4.5 Panel function extension

At this stage, there are 4 interfaces related to panel function expansion:
IInitPanel, IParamsPanel, IRefreshPanel, IDisposePanel
NOTE: IShowPanel, IClosePanel are deprecated.

e IInitPanel Used for panel initialization, the call timing is after OnEnable

‘summary

summar
= IInitPanel

summary

e IParamsPanel

param

ct @params);

o SetPanelObjectParams Triggered when calling ShowPanel with
parameters passed in.
o SetPanelStringParams Triggering requires both of the following
conditions:
1. No parameters were passed when calling ShowPanel.
2. When registering panel information, MainScriptParams in
IPanelAssetSettings configuration is not empty. The incoming
parameter is the value of MainScriptParams.

e [RefreshPanel Used when the panel refresh logic is not suitable for use in
Start or Awake.
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summary
summary

summary

summary
param name="instanc param
RefreshPanel(IPanelInstance instance);

e [DisposePanel Called when the panel is about to be destroyed to perform the
release behavior.

summary
summary
= TDisposePane
summary

summary
param name="instance" param
DisposePanel(IPanelInstance instance);

6.5 Example

JLGames/RocketDriver/Samples/Panel

BgCaolor

BgColor Print Registry

Glose By Instanceld

7. Service Framework (Service)

e JLGames.RocketDriver.CSharp.Service provides the basic interface and
behavior specification of the service framework.

https://www.xuzhuoxi.com/RocketDriver-Docs/pages/Manual_Full_en.html




2023/11/11 16:09 User Manual | RocketDriver Pro
e JLGames.RocketDriver.Actions.Service provides service configuration assets
for Unity (not enabled).
e JLGames.RocketDriver.Games.Service provides common service functions.

7.1 Design Purpose

Game projects have some obvious characteristics: high degree of data coupling
and strong system dependence.

So the entire game project can easily evolve into a monolithic software.

As there are more modules in the system, the monolithic architecture becomes
more complex. In addition, the interleaving of new functions and modification of
old functions affects each other and is ultimately difficult to manage.

In order to solve or reduce the impact of the above problems, combined with the
idea of service-oriented architecture(SOA), here is a solution and solve the
following problems::

e Realize logical separation of business modules
o Logical separation between different businesses
o Logical separation of data and display under the same business

e Extended support for normalized business modules
¢ Unify the specification of cross-business behavior calls

7.2 Design Ideas

e How to divide the service and how to grasp the granularity
1. All businesses in the range from “game login complete” to “game
logout start” are regarded as service division objects.
2. Divide service units on a regular basis. The division rules are as follows:
m Priority is given to dividing the game business and obtaining a
functional system.
» The functional system is further divided according to data, display
and management to obtain service units.
» Data reading and writing are isolated through the interface.

3. Design a functional open interface (read-only interface) for each service
unit.

4. The communication between service units adopts the event mechanism.

e According to the idea of IOC, extended business services are added to the
service framework management in the form of injection.

e According to the design idea of the game engine, an interface function called
at a fixed timing is added to the extended business service, which is used for
initializing data, releasing data or special logic implementation inside the
service.
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¢ All extension services are managed by the framework, which is convenient for
unified processing of initialization, update and release.

7.3 Interface description

7.3.1 Service Basics

e IService Only the class that implements the IService interface can be
identified as a service and added to the framework management.

The ServiceName property returns the service name, which is required to be
unique.

e IEventDispatcher The timing management of the service depends on the
event module, so the service implementation class is required to implement
the IEventDispatcher interface.

e ServiceBase Implement some necessary functions of the service class, which
can be used for inheritance.

e IProgressingService Provides a service interface for progress update.
Triggers a progress update when the service instance throws the
ServiceEvents.OnServiceProcessing event.

The service instance requires the attribute functions of total progress and
current progress.

summanry

fSuUmmary

IEventDispatcher

LsSuUmmary

summary -

summa iy

7.3.2 Service initialization related
Execution timing: IArgumentService -> IAWakableService -> IInitService

e IArgumentService Provides a service interface for parameter injection
The completion of the function execution represents the end of the process of
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injecting parameters.
Summary

summary
TArgumentService

summary
Summary

param name="args' param
InjectArgument(object[] args);

o IAWakableService A service interface that provides activation logic.
The completion of the function execution represents the end of the

activation process.
Lsummanry .

summary
1 TAwakableService

summairy

-5ummaPy:
: o

o IInitService A service interface that provides initialization logic.
When the service instance throws the ServiceEvents.OnServicelnited event,

it means the initialization process ends.

~SUummanry

e ITnitService : IService, IEventDisy

summanry
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o IInitDataService A service interface that provides data initialization logic.
When the service instance throws the ServiceEvents.OnServiceDatalnited
event, it means the data initialization process ends.

summanry

fSuUmmary

CsSUummanry

sSummanry

summary -

Summary

7.3.3 Management scheduling related

e IClearService A service interface that provides cleanup logic.
Mostly used for data reset, event removal and other logic.
The completion of the function execution means the end of the cleanup
process.

summanry

e IClearService

Csummary >

summary
I Clear();

o ILoadDataService Provides a service interface for data loading logic.
When the service instance throws the ServiceEvents.OnServiceLoaded
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event, it means the data loading process ends.

summanry

/summary
IloadDataService

< SUmMmary :

Ssummaiy

o ISaveDataService Provides a service interface for data storage logic.
When the service instance throws the ServiceEvents.OnServiceSaved event,

it means the data saving process ends.
summary .

summary >
interface ISaveDataService : IEventDispatcher

summanry

/ summary:
SaveData();

7.3.4 Event Description

7.3.4.1 Progress update related events

‘ring OnServiceProcessing = "S

summary

g OnInitializationProcessing

summary

/summar

ing OnInitializationFinish = "S

e ServiceEvents.OnServiceProcessing
o Scheduling body: a service instance that implements the
IProgressingService interface
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o Scheduling timing: when it is necessary to inform the listener of the

update progress.
e ServiceEvents.OnlnitializationProcessing

o Scheduling subject: ServiceManager

o Scheduling timing: During the initial execution period from
StartInitalization to endCall, it is scheduled when three events of
OnServiceProcessing, OnServicelnited, and OnServiceDatalnited are
captured.

e ServiceEvents.OnlnitializationFinish
o Scheduling subject: ServiceManager
o Scheduling timing: when the call to Startlnitalization ends, after the
execution of endCall.

7.3.4.2 Service preparation related events

summary

iz OnServiceInjected = "S

summary

iz OnServiceAllInjected = "5S¢

summary

sSummary

g OnServiceAwaked

summary

summa
g OnServiceAllAwaked

Dispatching order: OnServicelnjected > OnServiceAlllnjected > OnServiceAwaked >
OnServiceAllAwaked

e ServiceEvents.OnServicelnjected
o Scheduling subject: ServiceManager
o Scheduling timing: during the call to StartInitalization

e ServiceEvents.OnServiceAllInjected
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o Scheduling subject: ServiceManager
o Scheduling timing: During the call to StartInitalization, all services that
implement IArgumentService are processed.
e ServiceEvents.OnServiceAwaked
o Scheduling subject: ServiceManager
o Scheduling timing: during the call to StartInitalization

e ServiceEvents.OnServiceAllAwaked
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to StartInitalization, after all the
services that implement IAWakableService are processed.

7.3.4.3 Service initialization related events

~Summary

summa
12 OnServiceInitStart

Ssummary

ing OnServiceInited = "

summanry

summary
ing OnServiceAllInited = "5

summanry .

summar
ring OnServiceDataInitStart = "S

summary -

summary:

ing OnServiceDataAlllnited = "S

Dispatching order: OnServicelnitStart > OnServicelnited > OnServiceAlllnited >
OnServiceDatalnitStart > OnServiceDatalnited > OnServiceDataAllInited
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ServiceEvents.OnServicelnitStart
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to StartInitalization, process each
service before the behavior of the IInitService interface.

ServiceEvents.OnServicelnited
o Scheduling subject: service instance, ServiceManager that implements
IInitService
o Scheduling timing: After the service instance that implements
IInitService handles the Init behavior; ServiceManager captures the
former event and reschedules it.

ServiceEvents.OnServiceAllInited
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to StartInitalization, after all the
services that implement IInitService are processed.

ServiceEvents.OnServiceDatalnitStart
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to StartlInitalization, process each
service before the behavior of the IInitDataService interface.

ServiceEvents.OnServiceDatalnited
o Scheduling subject: service instance, ServiceManager that implements
IInitDataService
o Scheduling timing: After the service instance that implements
I[InitDataService handles the InitData behavior; ServiceManager
captures the former event and reschedules it.

ServiceEvents.OnServiceDataAllInited
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to StartInitalization, after all the
services that implement IInitDataService are processed.

7.3.4.4 Data loading related events
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summanry .

Summaty

tring OnServiceDataloaded = "

summary

e ServiceEvents.OnServiceDatalLoadStart
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to LoadServicesData, process each
service before the behavior of the ILoadDataService interface.

e ServiceEvents.OnServiceDatalLoaded
o Scheduling subject: service instance, ServiceManager that implements
ILoadDataService
o Scheduling timing: After the service instance that implements
ILoadDataService handles the LoadData behavior; ServiceManager
catches the former event and reschedules it.

e ServiceEvents.OnServiceDataAllLoaded
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to LoadServicesData, all services that
implement ILoadDataService are processed.

7.3.4.5 Data save related events
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summary

ing OnServiceDataSaveStart

summary

1 OnServiceDataSaved = "Se

summary

1 OnServiceDataAllSaved =

e ServiceEvents.OnServiceDataSaveStart
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to SaveServicesData, process each
service before the behavior of the ISaveDataService interface.

e ServiceEvents.OnServiceDataSaved
o Scheduling subject: service instance, ServiceManager that implements
ISaveDataService
o Scheduling timing: After the service instance that implements
ISaveDataService handles the SaveData behavior; ServiceManager
captures the former event and reschedules it.

e ServiceEvents.OnServiceDataAllSaved
o Scheduling subject: ServiceManager
o Scheduling timing: During the call to SaveServicesData, after all the
services that implement ISaveDataService are processed.

7.4 How to use the framework

Before getting the service to use, it must be registered to the framework
management, and then can be used after initialization. This is to ensure that the
data has been processed completely.

7.4.1 Register the service to the framework management

By calling the AddConfig function in the ServiceConfig instance, the service can be
registered with the framework management.
ServicecConfig.Shared.AddConfig(new ServiceInfo(serviceName,
serviceImpl, args));
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~SUummary

summary
param
param name nc = param
exception on'

fexception>
ool ignoreSame =

Suggest:

1. Manage the registration logic with a class dedicated to handling registration
services. Such as ServiceRegister in the example.
2. Registration logic calls should be guaranteed to be unique.

7.4.2 Service initialization

Start initialization by calling the StartInitalization function in the ServiceManager
instance.
Note: It should not be called repeatedly after initialization has started.

sSummarnry

Summatry

7.4.3 Service call
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After the initial completion of all services, the service instance can be obtained by
calling the GetService function in ServiceConfig.
There are multiple functions for obtaining service instances in ServiceConfig, but
the GetService function is ultimately called.

summary

/ summa
param serviceMamed"” param
return

> serviceNamed)

ceImpl(serviceNamed);

summary
param n:
<typeparam naz "SER I IERE ] < /typeparam:
returns
> named )

Suggest:

1. Manage the acquisition logic using a class that specifically manages acquiring
service instances. Such as ServiceCenter in the example.

7.4.4 Service cleanup

When the game is to achieve a soft restart, it is necessary to reset all services and
then reinitialize.

All services can be reset by calling ClearServices in ServiceManager.

Only services that implement the IClearService interface will perform reset logic.

https://www.xuzhuoxi.com/RocketDriver-Docs/pages/Manual_Full_en.html 59/88



2023/11/11 16:09 User Manual | RocketDriver Pro

~ SUummary .-

summary

< SUummanry

umima

s IClearService

LsSummanry .

Ssummarry

void Clear();

Suggest:

1. Each service is recommended to implement the IClearService interface.
2. In the Clear function in the IClearService interface, also clear all event
listeners.

7.5 Example

https://www.xuzhuoxi.com/RocketDriver-Docs/pages/Manual_Full_en.html 60/88



2023/11/11 16:09 User Manual | RocketDriver Pro

JLGames/RocketDriver/Samples/Service

Waiting

Waiting

Waiting

Waiting

Waiting

Waiting

Waiting

Waiting

Q.
Q:
Q:
Q::
Q::
=

Q:

Service description in example:

e ConfigDataService
1. Use ExcelExport to export the Excel header and data.

2. cfg.asset is the DirFilesIndex asset manager, which is used to manage

the path of Excel’s Json data.

3. Use the built-in Loader to load the cfg.asset and Json files and cache

them.
4. Init processing is complete.
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e PreloadService

1. Use PreloadSettings to manage the configuration information of
preloaded resources.

2. Use the built-in Loader to load the PreloadSettings asset.

3. Load resources according to the PreloadSettings configuration
information.

4. Init processing is complete.

e ResourceService Service implementation under the Material Data Framework.

1. Read the configuration from the ConfigDataService service.
2. Initialize by configuration.

3. Init processing is complete.

4. Simulate the generation of user data.

5. InitData processing is complete.

e DemoService The boilerplate service simulates different functions under the
same service logic by injecting parameters.

8. Rpg Material Data System

This is a general game data management system.
The player’s numerical data is managed in the form of KTV (Key-Type-Value).

¢ JLGames.RocketDriver.Games.RpgMaterial Provides functional support for
the Rpg material data system. The dependencies are as follows:
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pkg RpgMaterial p
Service Common

=

internalUtil E + DataNum

LRSS e e e e = E + DataNumUtils

+MaterialServiceEvertData Material E + DataOffset

+MaterialServiceEvents Malerial E + DataOffsetUtils

= + Materiaf

+MaterialServiceProxy = o E + DataRandNum
5 +MaterialDisplay

B +o0ffsetCompareTrigger = + DataRandomUtils
- e S — e e e e ==& +Materialoper % e
% +Trigger A eara + DataRandWeight
+ TriggerQueue &3 ety E + Elementset
iR User + MaterialSet E T

+ValidUti C . el
+ValueCompareTrigger + UniqueldGenerator Rk i E + GroupRandAvg
00 +MaterialService E + UserMaterial E Himteriahiaslamp E + GroupRandWeight

+ = ; F
00 +MaterialService + UserMaterialDisplay S MERADL E +MetaData

: + MaterialValidType z
©0 + IMateriolServiceDisplay E + UserMaterialOper ———, E +MetaDisplay
o0 4 |MaterialServiceDisplay + UserMaterialSet E : = +Metaoper
X o0 +linitMaterial
60+ iMaterialServiceMod E +UserMaterialvalid E + MetaValidDuration
= - o0 +IMaterial —+

o0 +|MateriaiServiceMod + UserMaterialWorth s e + Metavalidstamp
OO0 +IMateriolServiceOper o0 + UniqueldGenerator E +MetaWorth

00 #iUserMgterial  Fm———-- >OO + IMaterialDispiay E i
X s S0 + IMaterialDisplay

o0 +|MaterigiServiceValid | = 00 +[UserMaterial S0 + IMaterialdper E + UserNotifyData

o0 + IMateriaiServiceValid ©0 +[UserMaterialDisplay ) E + UserNotifyDataUtils

o0 +IMaterialOper
o0+ UserMaterialDisplay s i
o0 +IMaterialSet E + UserValidData

00 : IMaterialServiceOper

0 + IMaterialServiceWorth

00 + (MaterialServiceWorth o0 +lUserMaterialGenerdt or = 00 +|DataRandomable
00 + [UserMaterialGenerdt o0 +IMaterialSet
OO +ServiceTriggerProxy biserMatena e a X O +IElement
: v ©0 + MaterialSethMod
00 +ServicelipdateProxy 00 +|UserMaterialMod ) 00 : IlementSet
X . o0 +IMaterialSetMod
©0 4 (TriggerContainer 00 +[UserMaterialOper P R 0Q ¢ [ElementSet
2 +
o0 4 TriggerEntity ®0 +|UserMaterialOper e o0 + ISerializeDataBinary
o0 +|UserMaterialSet 20 wlMaferalVoid i
o0 .+ TriggerHandler : ; o0 4 SerializeDatalson
A BHISEE o0 + IMaterialWorth
OO +(TriggerRegister o0 +|UserMater i 0O + [SeriglizeDatastring
. . o0 + IMaterialWorth
O +|UserMaterialSetMod 00 4 [UserDato
(fram RpgMateriai) 3
©0 +[UserMaterialSetMod (from RpgMaterial} = 00O 4 UservalidData
oot o0 +[UserMaterialValid y
rom RpgMateria
o0 +|UserMaterialVolid (f o )
E LRI | = o0 +[UserMaterialValid\Mod

Valiel
E +MaterialassetvalidData °Q +(UserMaterialWorth

o0 +|UserMaterialWorth

{from RpgMaterial) (from RogMaterial)

o JLGames.RocketDriver.Games.RpgMaterial.Common The basic data
structure of the system.

o JLGames.RocketDriver.Games.RpgMaterial.Material A data structure
in the system about material definitions.

o JLGames.RocketDriver.Games.RpgMaterial.User The data structure in
the system about user data storage.

o JLGames.RocketDriver.Games.RpgMaterial.Service The data structure
in the system that provides external interface support.

o JLGames.RocketDriver.Games.RpgMaterial.Asset The data structure

in the system that is serialized for Unity.

8.1 Design Ideas

e Metadata (configuration data) of user data is managed in KTD(Key-Type-
Define) format.

e The source of metadata (configuration data) can be derived from value table
export, server acquisition, asset configuration, etc.

e Through KT(Key&Type), the metadata (configuration data) definition (Define)
can be obtained, and the validity can be checked when the user data is set.

e User data is managed in KTV(Key-Type-Value) format (memory, local file,
server, etc.).

e Under the same metadata definition, if multiple pieces of user data are
required, they will be saved in the form of KTUV(Key-Type-UId-Value), which
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is compatible with both common data formats and multiple pieces of data.
Require.

e User data (Value) usually uses basic numerical types to meet the needs, of
course, game designers can expand the storage structure of data.

e Through KT(Key&Type) or KTU(Key&Type&UId), the player’s specific data
(Value) can be obtained for calculation and display.

e Changes to user data are issued in the form of notifications, supporting both
incremental changes and direct updates.

8.1.1 Common module design instructions

e Provides basic management functions of data objects and defines the most
basic interface of data objects.

e Provide the most basic configuration data interface definition and related
data structure implementation.

e Provide the most basic user data interface definition and related data
structure implementation.

e Provides optional extension interface definition.
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e Provides data structure implementations for basic computations.
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class Common
wstruct»
DataRandNum
~  m_id:int {readOnly}
= m_Max:int
~ m_Min:int
- m_None: D = new D ) {rescDniy}
~  m_Type: int {readOnly)
- SepEntity: char ='&'
- SepField: char ="'
4+ Array ing, char, charl: D umf]
+ DataRandNum(int, int, int,nt} |
+  FromString(string, char}: DataRandNum 1
+ RandToDataNum(): DataNum 1
+  RandToDataOffset(bool): Dataoffset i
+  ToString{): string |
<property» i
4 1d(:int 1
o +  lsNane(): bool .
GroupRandweight = Mt i
+ Min(): int !
- m None: = new. {readDriy} + Type():int |
- m_Rands: DataRandWeight ([]) freadOnly} v
- SepEntity: char="]' B
= SEpRBdiEneE IDataRandomable
- SepGroup: char
+  ArrayFr ing, char, char, char}: - = = e e e e e i e S e e e e e [>>+ RandToDataNum(): DataNum
+  Fromstring|string, char, char]: #  RandioDatanicHiodliEb S e
+ GroupRandWeight(DataRandWeight])
+  Randindex(): int wstructs /_\ A
+ RandToDataNum(): DataNum DataRandWeight | N
+ RandToDataOffset(bool): DataOffset | \
~ m_Id: int {readOnly} H H
Sproperyn - m_None:D. = new D, () frenchnly} | |
+ IsNona(): bool % - ] |
m_Num: int H '
~  m_Type: int {readOnly} i |
~  m_Weighta: int : !
- RandMax: int = 10000 | 1
- RandMin: int=0 : :
- SepEntity: char | |
SepField: char = : :
m Rands| + Array char, char): DataRandweight[] ! .
- + CheckHitf:bool X L ___] ] 1
+ DataRandWeight{int, int, int, int) :
+ string, charl: D: h |
+ RandToDataNum(}: DataNum |
+ RandToDataOffset(bool): DataOffset !
+ ToDataNumi): DataNum 1
+ ToDataOffset{bool): DataOffset !
+  ToString(): string |
aproperty» |
+ Id():int 1
+ IsNone(): bool :
+  Num(}: int 1
+  Type(): int :
+  Weight(): int |
1
i
I
i
«interfacen !
lUserValidData 1
|
+ SetGainstampilong): waid :
i «property» |
. +  GainDescLocall}: string !
UserValidData +  GainDescUTC(): string «interfaces 1
+ Gainstamp): long Lzt :
- GainFormatLocal: string = "yyyy-MM-od HH:. . - H
- GainFormatUTC: string = "yyyy-MM-dd HH: + :Et;?(’"’(}::;“zﬁ |
- +  SetNum(int): |
B! fdm o +  SetType(int): vad :
+ SetGainstamp(long): void UserData [+ Setuid(int): void |
 Fastingl) e # m_idiint “property» :
“property» #  m_Num:int +  Idf):int !
+ GainDesciocal(): string & m_Typerint +  Num():int ;
+  GainDescUTC(): string # m_Uid:int +  Type():int |
+  Gainstamp{}: long — +  Uld{):int 1
+  Setid(int): void :
+  SetNum(int): void /_\ H
> T T Rt o !
+ setUid(int): void !
+  ToString(): string |
ElementSet «propertyn '
+ Id():int !
# m_Datalist: List<IElement> {readOnly} + Numipint !
- m_Temp: List<IElement> = new List<IElement>() {readOniy} LS.
+ Typel)int !
+  AddElement(IElemant): void +  Uld(): int i
+  AddElements{|Enumerable<TAs>): void !
+  ElementSet() |
+ Elementset(int) 1
+  Exist(string): bool !
+ ForeachElement{Action<TAs>): void |
+ GetElement(string): IElement :
+ GetElement(string): TAs I
+ GetElement(Predicate<TAs>): TAs |
+  GetElements{stringf]): TAS[] e }
+ GetElements(|Enumerable<string=): TAs[] IElement !
+ GetElements(Predicate<TAs=): TAs[] Sirm Gt !
+ GetElements(): TAs[] astruct» = \
- RemovaEle(string): TAs GroupRandAvg 0, mEKZ“-’st' !
+ RemoveElement(string): IElement vl string :
- m None: = new ) [reacDriy}
+ RemoveElements(string[]): IElement(] !
e ; - m_Rands: DataNum {[]) {readOnly} . |
i g ,) - SepEntity: char—"] -m_TempBase/ [\ 0.. !
+  RemoveElements(): [Element(] = el ol '
+ ReplaceElement(iElement): void e e I s 4
+  ReplaceElements(|Enumerable<TAs>): void +  ArrayFromStringistring, char, char, char}: l]
+ Sortelements(iComparer<iElement=): void + I [ char, char): Gr
+  SortElements(Comparison<iElement>|: vaid + GroupRandAvg(DataNum(])
- ToAs{iElement): TAs +  Randindex(): int
apropertys + RandToDataNum(): DataNum
+  Size():int + RandToDataOffset{bool): DataOffset
' «aproperty»
i +  IsNone(): bool
I
1
I
|
i
) MetavalidDuration sEnume abons
H Unit
| # m_DurationUnit: Unit
! # m_validDuration: long #m_Durationunit Tick
' + Checkinvalid{long): bool A
1 + MetavalidDuration() Minute
' + MetaValidDuration{long) Hour
i + MetaValidDuration(Unit, lorg) Day
1 +  ToString(): string
i «property»
} - UnitTicks(): long
| + ValidDuration(): long -m_Rands\ ;
' +  Validenabled(): bool
i +  ValidTicks{): long wstructs
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DataNumUtils

- m TempNum: List<C =new ki

) {reariOnly}

extension»
Append({DataNum, bool): DataNum
Append(DataNum([], bool): DataNum|
ClearByl : DataNum{]
ClearByZerof): DataNum|

): DataNum(]

Merged(): DataNum
ToOffsetData(bool): DataOffset
ToOffsetData(bool): DataOffset]

oo+ o+

-m_TempNum

~  m_ld:int {readOniy}
- m_None: DataNum = new DataNumi) {readOriy} |
~m_Num:int

~  m_Type: int {readOnly}
~  m_Uld:int freadOnly}
- SepEntity: char="&'

- SepField: char ="

Arrayf char, char}:
DataNum(int, int, int, int)

ElementSet

m_DataList: List<T> {readOnly}
m_Temp: List<T> = new List<T>() {readOnly}
m_TempBase: Li > = new L

{) {rescDnly}

[ T T T T

W R ed F R &

+

o

Add(T: void
AddElement(IElement): void
AddElements{iEnumarable<TAs>): void
AddRange{iEnumerable<T=): void
ElementSet(}

ElementSet(int)

Exist{string): bool

Foreach{Action<T>): void
Foreach(Action<TAs>}: vaid
ForeachElement{Action<TAs>}: void
Getfstring): T

Get(predicate<Ts): T

GetAll(): T[]

GetAllAs{): TAs]]

GetElement(string): IElement
GetElement{string): TAs
GetElement(Predicate<TAs>): TAs
GetElements{string]): TAs]
GetElements{IEnumerable<string=}: TAs[]
GetElements{Predicate<Tass): TAs]]
GetElements(): TAs[]
GetRange(string(]): Tl

GetRange(IEnumerable<string=): T[]

GetRange(Predicate<T>): T(]

Remove(string): T

Remavell(): T(]

RemoveEle(string): T

RemoveElement(string): IElement

RemoveElements(string[]}: IElement(]
5

)
RemoveElements(): [Element]]
RemaveRange(string[]): TI]
RemoveRange(IEnumerable<string>}: T[]
RemoveRange(Predicate<T=): T[]
Replace(T): void
ReplaceElement(iElement): void
ReplaceElements(IEnumerable<TAs:): vaid
ReplaceRange(|Enumerable<T>): void
Sort(IComparer<T>}; void
Sort(IComparer<Ths=): void
Sort({Comparison<T>}: void
sort{Comparison<TAs=): void
SortElements(IComparer<iElement:: void
sortElements(Comparison<IElement=): void
ToAs(T): TAs

«property»

size(): int

indexars

this{int): T

DataOffsetUtils

-m_TempOffset

Eromstring(string, char): DataNum
operator -{DataNum, int}: DataNum
operator {DataNum}: DataNum
operator *(DataNum, int): DataNum
operator +{DataNum, int): DataNum
Tostring(): string

uproperty»
1d(): int
IsNone(}: bool
Num(): int
Type(): int
uid(): int

0.*

FoE ottt

P

wstructs
DataOffset

~  m_id:int {readOnly}

~  m_Offset: int
~  m_Type: int {readOnly}
~  m_Uld: int {readOnly}
- SepEntity: char='&'

- SepField: cha

char, char}: DataOffset]]
DataOffset(int, int, int, int)
Fromstring(string, char): DataOffset

- m_TempOffset: List<Dataoffset> = new List<DataOf... {readOnly} |

wextensions
Append(Data0ffset, bool): DataOffset]
Append(Data0ffset[], bool): DataOffset]

Clearayf DataOffset>); DataOffset]]

5.
.
+
+ ClearByZero(): DataOffset]
iy
+
-
=

redicate<DataOffsets): DataOffset]]
Merged(): DataOffset]]

ToAbsNumData(): DataNum

ToNumDatai): DataNum(]

«winterfacen
IElementSet

Add(T): void
AddRange{IEnumerahla<T=}: void
Foreach(Action<T>); void
Foreach(Action<TAs>]: void
Get{string): T

Get{PredicatexTs): T

Getall(): T[]

operator -(DataOffset, int): DataOffset
operator -(DataOffset): DataOffset
operator *(DataOffset, int): DataOffset
operator +{DataOffset, int): DataOffset
ToString(): string

apraperty»
AbsOffset(): int
1d{): int
IsNane(): baol
Offset(): int
Typef): int
uid(): int

0.*

o EE o+t

ok bttt

finterfacen
IElementSet

AddElement(IElement): void
AddElements{ Enumerable<TAs>): vaid
Exist{string): bool
ForeachElement{Action<TAs>}: void
GetElement{string): IElement
GetElement(string): TAs
GetElement(Predicate<TAs>): TAs
GetElements{string[]): TAs[]
GetElements{IEnumerable<strings): TAs]]
<TAs>): TAsT]

GetRange(string(]): Tl
GetRange(|Enumerable<string>): T[]
GetRange(Predicate<T>): T[]
Removefstring): T

RemoveAll(): T(]
RemoveRange(string[]}: TI]
RemoveRange(IEnumeratiesst ring=}: Tf]
RemoveRange(Predicata<T>): T[]
Replace(T): void
ReplaceRange(IEnumerable<T=): void
Sort(iComparer<T>}: void
Sort{IComparer<TAs>}: void
Sort{Comparison<T>}: void
Sort(Comparison<TAs=}: void

e i T T T

«windexer»
+  thisfint): T

UserNotifyDataUtils

GetElements{): TAs[]
RemoveElement(string}: IElement
RemaoveElements(string(]): IElement(]
RemoveElements{IEnumerable<strirg=): Hement(]
RemoveElements{Predicate<|Elemert>}: Eemaif]
RemoveElements(): [Elemant]]
ReplaceElement{iElement): void
ReplaceElements{iEnumerable<TAs=): void
SortElements(IComparer<iElements): void
SortElements{Comparison<iElement>}: void
«propertys
+ Size():int

B T

- m_None: DataOffset = new DataOffset() freadOriy} |

astructs
UserNotifyData

~ m_id: int {readOnly}

~  m_Type: int [readonly}
m_Uld: int {readOnly}

operator DataNum (UserNotifiData
operator DataOffset{UserNotifyData) |

2

-m_TempData

m_TempData: List<UserNotifyData> = new List<UserNo. .. {readOnly
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Tostring(): string
UserNotifyData(int, int, int, int, int)
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0.*
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wextension»

Append(UserNotifyData, bool}: UserNotifyDatal]
Append{UserNotifyData[], bool): UserNotifyData|

ClearByFilter (Predicate<UserNotifyData=): UserNotifyDatal

ClearByZero(): UserNotifyDatal

Merged(): UserNotifyData|

psiag
AbsOffset(): int
Id(): int

Num(): int
Offset(): int
Type(): int
uid(): int

O

MetaData

#  m_Desc:string
# m_id:int

#  m_timit: int (0)
# m_Name: string
# m_Type:int

+  CheckLimitfint); int
+ MetaData()
+ MetaDatafint, string, int, irt, int, string)
+  ToString(): string

«property»
+  Desc(): string
+df):int
+  LimitMax(): int
+  LimitMin(): int
+ Name(): string
+ Type(): int

MetaDisplay

#  m_Weight:int

+  MetaDisplay)

+  MetaDisplayint, irt, int)

+ ToString(): string
aproperty»

+  lconid(): int

+  Quality(): int

+  Weight():int

MetaOper

# m_OperMark: int

+ CheckOperability(int}: bad

+  MetaOper(}

+ MetaOper(int)

+  ToString(): string
«property»

+  OperMark(): int

MetaValidStamp.

#  m_validend: long
# m_validstart: long

+  Checkaftervalid{long): bool

+ CheckBefareValid{long): bool

+  Checkinvalid{iong): bool

+ MetaValidstamp()

+  MetaValidstamp(long, long)

+  ToString(): string
«praperty»

+ ValidEnabled(): bool

+  ValidEnd(): long

+  Validstart(): long

MetaWorth

#  m_Worth: int

+  GetNumByWarth(int, bool: ik
+  GetWorthByNum(int}: int
+ MetaWorth()
+ MetaWorthfint)
+ Tostring(): string
«property»
+ Worth():int

DataRandomUtils

wextensions

+ RandToDataNums{): DataNum

+ RandToDataOf Dt a0ffsec []

winterfacen
IserializeDataBinary

+  FromBinary(bytel]): vad
+ ToBinary(): bytel]

winterfacen
IserializeDatalson

+  Fromisonstringfstrirg]: \woid
+  TolsonString(): string

«interfacen
ISerializeDataString

+  FromStringData(string): void
+ TostringData(): string
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8.1.1.1 Common interface design

e [Element Data Object Base Interface

e [ElementSet Data collection base interface for managing IElement objects.

e JUserData, IUserData, IUserValidData, IUserValidData1 User data related
interface.

o [SerializeDataBinary, ISerializeDataJson and ISerializeDataString Data
serialization related interface.

e IDataRandomable Number of random related interfaces.

8.1.1.2 Common data structure design

e ElementSet The implementation class of IElementSet provides management
functions for I[Element objects, which can be used for inheritance or
combination.

e Configuration data related data structures
o MetaData Configuration data base, including Id, name, type, size
constraint, description.
o MetaDisplay Configuration data displays related data, including icon ID
. display weight and display quality .
o MetaOper Configuration data manipulation behavior settings, including
bit-wise defined values.
Operation behavior settings:
= Assume that the 1st bit of the binary is defined as usable and the
2nd bit is defined as discardable.
= When the value is binary (11), it means that the data definition can
be used or discarded.

o MetaWorth Configure data value to define relevant data, including value.
Value Definition:
= The marked unit price of the type market item.
= For quantity comparison and calculation between different
configurations.

o MetaValidDuration Configure the data related to the validity period of
the data.,
o MetaValidStamp Configuration data valid time interval related data,

e User data related data structures
o UserData User data base, including Id (corresponding to the Id of
MetaData), type (corresponding to the type of MetaData), quantity
o UserDatal Inherited from UserData, add the unique Id property.
o UserValidData Inherited from UserData, adding the timestamp attribute,
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o UserValidData1 Inherited from UserValidData, add the unique Id
property.
e Calculate and notify related data structures
o DataNum
» Id, type Used to locate configuration data items and user data
items
m quantity Used to override the quantity in the user data item

o DataOffset
m [d, type Used to locate configuration data items and user data
items
m offset value Used to add to the quantity in the user data item, the
result overwrites the quantity in the user data item

o UserNotifyData After updating the user data through the DataNum and
DataOffset data, the UserNotifyData result can be calculated to notify
the front-end display effect.

e random correlation data structure

o DataRandNum Randomize the mean between the minimum and
maximum values.

o DataRandWeight There are only two results, true and false, for the
random weights.

o GroupRandAvg Random one of multiple values, with average
probability.

o GroupRandWeight Random one of multiple values, the probability
depends on the weight.

8.1.1.3 Common tool class design

e DataNumUltils Behavior logic related to DataNum

e DataOffsetUtils Behavior logic related to DataOffset

e UserNotifyDataUtils Behavior logic related to UserNotifyData

e DataRandomuUtils Random logic for the class implementing the
IDataRandomable interface

8.1.2 Material Module Design Instructions

e Provides common interface definitions and related implementations for
configuration data.
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e Combination of interfaces and data structures in Common.
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m_Data: MetaData
# m_RawData: TCfg

+ CheckLimit(int): int

+ GetDescl}: string
Tastring(): string
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Descf): string
EKey(): string
Idf): int
LimitMax(): int
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+

UpdateSet{IElementSet<TV=}: wid
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¥

ExistMaterial(int): bool

ForeachMaterialAs{Action<TMAs>): void

GetMaterialAs{int): TMAs
GetSizeAs(Predicate<TMAs>): int
MaterialSet()

MaterialSet{iElementSet<iElement>)

UpdateSet(IElementSet): void

“property»

MaterialSize(): int

MaterialSet —l

________ > +  UpdateSet(IElementSet): void

None
Stamp
Duration
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winterfaces
IMaterialSet

winterface
IMaterialSetMod

TM > IMaterial<TCfgs
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ForeachMaterial{Action<TM>) : woid
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GetMaterials(Predicst e<ThM>): TMI]
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+ o+
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MaterialSize(): int

Iy

https://www.xuzhuoxi.com/RocketDriver-Docs/pages/Manual_Full_en.html

73/88



2023/11/11 16:09

User Manual | RocketDriver Pro

M_EIEMENTS: IEIEMENTIBTL | V> [FEaauny}

I

|
ExistMaterial{int): bool |
ForeachMaterial{Action<TM=>}: vaid ;
ForeachMaterialAs{Action<TMAs=}: void |
GetMaterial(int): TM :
GetMaterialAs(int): TMAs I
GetMaterials(Tm#g =~ f-—————-
GetMaterials{Predicate<TMz=): TM[]
GetSize(Predicate<TM:=): int
GetSizeAs(Predicate<TMAs=>}: int
MaterialSet()
MaterialSet(|ElemeniSet<TM=>)
UpdateSet{IElementSet): void
UpdateSet{IElementSet<TM:>]: void

++ 4+ ko 4+ W

aproperty»
+ MaterialSize(): int

8.1.2.1 Material interface design

IMaterial Inherited from IElement and defines common properties and
functions of configuration data.

IMaterialDisplay Inherited from IMaterial, it further defines the properties
and functions of configuration data with display function.

IMaterialOper Inherited from IMaterial, it further defines the properties and
functions of configuration data with operational behavior.

IMaterialWorth Inherited from IMaterial, it further defines the properties and
functions of the configuration data with valuable definitions.

IMaterialValid Inherited from IMaterial, it further defines the properties and
functions of time-tested configuration data.

IMaterialSet Inherited from IElementSet and defines common functions for
configuring data collections.

I[InitMaterial, IInitMaterial<TCfg> Defines the initialization logic interface for
configuration data.

8.1.2.2 Material data structure design

Note: The logical implementation of the following data structure depends on the
array structure in Common, and the usage method is combination.

Material An abstract class that implements IMaterial, implements some
functions, and subclasses can override behavior.

MaterialDisplay The abstract class that implements IMaterialDisplay
implements some functions, and subclasses can override the behavior.
MaterialOper The abstract class that implements IMaterialOper, implements
some functions, and subclasses can override the behavior.

MaterialWorth An abstract class that implements IMaterialWorth, implements
some functions, and subclasses can override the behavior.
MaterialValidDuration An abstract class that implements IMaterialValid,
implements some functions, and subclasses can override the behavior.
MaterialValidStamp An abstract class that implements IMaterialValid,
implements some functions, and subclasses can override the behavior.

8.1.3 User module design description
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e Provides normal user data functions.
e Provides user data function with unique Id.
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e Provides functionality for managing user data collections.
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8.1.3.1 User interface design

IUserMaterial and IUserMaterial1
o IUserMaterial Inherited from IElement, defines the properties and
functions of user data.
o IUserMaterial1 Inherited from IUserMaterial, adding a unique Id

property.

IUserMaterialDisplay and IUserMaterialDisplay1
o [UserMaterialDisplay Inherited from IUserMaterial, adding properties
and functions related to the display function.
o IUserMaterialDisplay1 Inherited from IUserMaterialDisplay, adding the
property of Unique Id.

IUserMaterialOper and IUserMaterialOper1
o IUserMaterialOper Inherited from IUserMaterial, adding properties and
functions related to operation behavior.
o [UserMaterialOper1 Inherited from IUserMaterialDisplay, adding the
property of Unique Id.

IUserMaterialWorth and IUserMaterialWorth1
o IUserMaterialWorth Inherited from IUserMaterial, adding value-related
properties and functions.
o IUserMaterialWorth1 Inherited from IUserMaterialWorth, adding the
unique Id attribute.

IUserMaterialValid and IUserMaterialValid1
o IUserMaterialValid Inherited from IUserMaterial, adding properties and
functions related to time inspection.
o IUserMaterialValid1 Inherited from IUserMaterialValid, the unique Id
property is added.

[UserMaterialMod and IUserMaterialMod1
o IUserMaterialMod Define the modification interface of user data
o IUserMaterialMod1 Inherited from IUserMaterialMod, a unique Id
attribute modification interface is added.

IUserMaterialValidMod and IUserMaterialValidMod1
o IUserMaterialValidMod Inherited from IUserMaterialMod, added the
user to obtain the timestamp modification interface
o IUserMaterialValidMod1 Inherited from IUserMaterialValidMod, the
unique Id attribute modification interface is added.

IUserMaterialSet Define the interface related to reading and searching in the
user data collection

https://www.xuzhuoxi.com/RocketDriver-Docs/pages/Manual_Full_en.html

79/88



2023/11/11 16:09 User Manual | RocketDriver Pro
e JUserMaterialSetMod Define the interface related to modification in the user
data collection

8.1.3.2 User data structure design

Note: The logical implementation of the following data structure depends on the
array structure in Common, and the usage method is combination.

e UserMaterial and UserMaterial1
o UserMaterial The abstract class that implements IUserMaterial,
implements some functions, and subclasses can override the behavior.
o UserMaterial1 The abstract class that implements [UserMaterial1,
implements some functions, and subclasses can override the behavior.

e UserMaterialDisplay and UserMaterialDisplay1
o UserMaterialDisplay The abstract class that implements
IUserMaterialDisplay implements some functions, and subclasses can
override the behavior.
o UserMaterialDisplay1 The abstract class that implements
IUserMaterialDisplay1, implements some functions, and subclasses can
override the behavior.

e UserMaterialOper and UserMaterialOper
o UserMaterialOper The abstract class that implements
IUserMaterialOper, implements some functions, and subclasses can
override the behavior.
o UserMaterialOper1 The abstract class that implements
IUserMaterialWorth1, implements some functions, and subclasses can
override the behavior.

e UserMaterialWorth and UserMaterialWorth1
o UserMaterialWorth The abstract class that implements
IUserMaterialWorth, implements some functions, and subclasses can
override the behavior.
o UserMaterialWorth1 The abstract class that implements
[IUserMaterialWorth1, implements some functions, and subclasses can
override the behavior.

e UserMaterialValid #1 UserMaterialValid1
o UserMaterialValid An abstract class that implements IUserMaterialValid
to achieve some functions, and subclasses can override the behavior.
o UserMaterialValid1 The abstract class that implements
IUserMaterialValid1, realizes some functions, and subclasses can
override the behavior.
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e UserMaterialSet The abstract class that implements IUserMaterialSet,
implements some functions, and subclasses can override the behavior.

8.1.4 Service Module Design Instructions

e The design of material Service extends the function of Service Framework.
e The classification of the material Service should correspond to the type

(referring to the type in the configuration data) one-to-one, that is, a type
creates a Service.

e Provides the basic interface definition of Material Service.

e Provides basic interface definitions for displayable materials, actionable
materials, and valuable materials.

e Provides a default implementation class of material service, which can be
used as needed. Direct modification and inheritance are not recommended.
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preType, i, gz g bk )

8.1.4.1 Service interface design

e IMaterialService Basic interface definition for Material Service.

o [MaterialServiceDisplay Displays the basic interface definition of the Material
Service.

o [MaterialServiceOper Basic interface definition for the Actionable Material
Service.

e IMaterialServiceWorth Basic interface definition for Value Material Service.

e [MaterialServiceValid The basic interface definition of Aging Material Service.

e IMaterialServiceMod Modification-related interface definitions for material
services.

8.1.4.2 Service Logic Design
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e MaterialService A default material service implementation class that can be
used on demand. Direct modification and inheritance are not recommended.
Internal functions are composed of functional units in User, Material, and
Common.

e ServiceUtil Provide some basic logic functions related to service.

8.1.5 Asset Module Design Instructions

class Asset

iCloneable {Cloneable
MaterialAssetData MaterialAssetValidData
+ Mid:int + Gain: long
+  Mum:int + Mid: int
+ Uid:int + Mum:int
+ Uid:int
+ Clone(): MaterialAssetData
- Clone(): ohject + Clone(); MaterialAssetVdidData
+ FromUseriaierial{TU}: TD - Clone(): object
+ FromUserMaterials{TU[]}: TD[ + FromUserMaterial{TU): TD
+ FrombserMaterals(TUll): MD[] + FromUserMaterials{TU[]): TOI]
+ ToString(): string + FromUserMaterials{Tu(]): TDI]
+ ToUserMaterial(TD, int): TU + ToString(): string
+ ToUserMaterals{TD[], int): TUI] + ToUserMaterial(TD, int}: TU
+ ToUserviatends{TD[], int)h: MU[] + ToUserMatends{TD[], int): TUJ]
+ ToUserMatends(TD[], int): MU

e MaterialAssetData Serialized structure of material user data, used in Unity
panels.

e MaterialAssetData1 Serialized structure of material user data with unique Id
for use in Unity panels.

e MaterialAssetValidData Serialized structure of material user data (with
acquisition timestamp) for use with Unity panels.

e MaterialAssetValidData1 Serialized structure of material user data (with
acquisition timestamp) with unique Id for Unity panels.

8.2 Use

Depends on the service framework(JLGames.RocketDriver.Games.Services), and
the specific usage process is consistent with the general service.

8.2.1 Classification of material data

Classify material configuration table data according to business needs
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8.2.2 Prepare the interface

Create a service interface for each type of material, at least inherit IInitService,
IInitDataService, IMaterialService

e IInitService Used to initialize material configuration data
e IInitDataService Used to initialize material user data.
User data source:
1. Server request
2. Local cache file
3. Other sources

e [MaterialService Provides some material-related properties and functions.
8.2.3 Implementing the interface
Implement the interface created in the previous step.

8.2.4 Configure and initialize according to the service framework process

According to the [Service Framework Description] (Manual_7.Service_en.html#7.4),

register, initialize, and call.
8.2.5 Other functions

e By default, an event is thrown when the user data changes. Perform logic
processing after data change by listening to corresponding events.

e Supports trigger function by default, and supports trigger execution when
user data changes.

8.3 Example
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JLGames/RocketDriver/Samples/RpgMaterial

Insert

Delete

Id

0

Query

HifFHE  Type=1, Id=0

UserResource[Type=1,MId=1001,Num=2]
UserResource[Type=1,MId=1002,Num=89]

Update

e Example Explanation

1. Provides examples of three material types: Resource, Item, and Giftbag.

1:55:20: Type=1, Id=1002, Nane=4 i1, Offset=-1 [Decrease]
:19: Type=1, Id=1002, Nane=%. Offset=100 [New]
7: Type=1, Id=1001, Nane==F, Offset=1 [Increase]
3: Type=1, Id=1001, Nane=%7, Offsef=1 [New]

002 NotEqual 1001 Notify{ld=1002, Ty 1Num-1w0ﬁset 10&}
11002 NotEqual_ 1001 |Notify{id=1002 Type-mum-'lﬁo Offset=100)/

Type: 1 Valid Id: 1001 - 1002
Type: 2 Valid Id: 2001 - 2029
Type: 3 Valid Id: 3001 - 3005

Exchangeld: 1 - 10

2. An example of the material exchange function is provided.
3. Provided an example of opening function of gift bag (Giftbag).

9. Lua Interpreter

¢ Introduce a lightweight open source Lua interpreter: Lualnterpreter.
e Function extensions and optimizations to make it work better in Unity.

9.1 Library Description

9.1.1 Information Description

e Name: Lua Interpreter

e Author: Liu Junfeng

e URL: http://www.codeproject.com/Articles/228212/Lua-Interpreter
e License: MIT (http://opensource.org/licenses/mit-license.php)

9.1.2 Modification Description

1. Removed WinFrom related code logic.

2. Function extension of LuaTable class.

3. Added several functions related to LuaValue.

4. Add Unity to use the packaging class Lua, which is also a common function

entry.
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9.2 Use

9.2.1 Execute Lua script in C#

1. Call the Lua.RunLuaRaw function, or directly execute the Lua script. If there is
a return value, get the return value.

mary >

/S ummary
<param
<param ] >< /param>

» luaCode, bool allowExceptions = fal

ing.IsMullOrEmpty(luaCode))

1 LuaInterpr nt er{luaCode, m_En
(Exception)

if (allowExceptions) thr

2. Call the Lua.RunLua function to execute Lua scripts. And the wrapper class
LuaResult is returned for the return value.

mmary ..

-« /param?
s luaCode, bool allowExceptions =

ew LuaResult(RunLly i luaCode, allowExceptions));

3. Call the Lua. IsTrue function to directly judge the Lua logical expression and
obtain the resulting Boolean value.

Lim

(luaCondition)) return fal

9.2.2 Call C# function in Lua
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1. First, the C# function needs to be registered in the Lua interpreter
environment. We can use the Lua.RegisterFunction function to execute
the registration logic.

LT

mmary >
<param param>
<param

o funcName, object target, MethodInfo method)

funchame) ) ) turn;

, method);

2.In the Lua script, use the registered funcName to call the registered function.

3. If the same funcName is used repeatedly for registration, it will be
overwritten.

4. Use the Lua.UnregisterFunction function to unregister the behavior.

Lsummanrmy

on{string funcName)

shull (funchame)) return;
Seth ue(funcName, LuaNil.Nil);

9.2.3 Restart Lua Interpreter

1. Use the Lua.Restart function to reset the Lua interpreter, which will clear all
contexts.

CSUummary

9.3 Examples
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JLGames/RocketDriver/Samples/LuaDemo

()

t={f=function() end, "blah"}

i=-1;
ifi == 1 then
print("bad");

elseif i == -1 then

print("good”);
else

print("bad2");
end

a=nil
b, c = false, true
d=1235
e = "text”

https://www.xuzhuoxi.com/RocketDriver-Docs/pages/Manual_Full_en.html

good

Hello, Lual
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600
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